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Service Overview

Welcome to ACH Filter
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ACH Filter Credit and ACH Filter Debit are two separate services designed to empower our customers with the ability to
prevent financial loss due to unauthorized incoming ACH debit and credit transactions. Certain types of fraudulent ACH
debit and credit transactions must be returned to the originating financial institution by the opening of the 2nd business

day following the settlement date. This means businesses must identify these transactions same day and return any

unauthorized transactions immediately to prevent financial loss.

This guide is intended to provide information to customers to aid in using this service in a manner that suits their specific

needs.

A. Introduction to ACH Filter Credit and Debit

This guide will outline all ACH Filter Credit and ACH Filter Debit functionality. A list of ACH Filter Credit and ACH
Filter Debit Features are set forth below.

Feature Name

Description

ACH Filter Credit and
ACH Filter Debit

Approved List

Allows Customers to identify
companies that can
debit/credit an account or
accounts and set
parameters to control the
debit activity.

Blocked List

Allows Customers to identify
companies that are NOT
allowed to debit/credit an
account or accounts.

Notification Rules

Establishes who should be
alerted, how they should be
alerted and the conditions
that should prompt an alert.
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Feature Name Description

ACH Filter Credit and
ACH Filter Debit

If the user has been granted
the Change Status user
privilege and then
transaction is eligible for a v
decision, the Customer will
be able to make pay/return
decisions on ACH Debits or
Credits.

Change Transaction Status

Allows Customers to
designate dual approval v
parameters on transaction
decisioning.

Dual Decisioning

Allows a user to view data
on the following features:
Reports e Notification Rules
e Approved List

e Block List

The first section of this guide will cover features of ACH Filter Credit and ACH Filter Debit that are essentially the same in
both modules. The second section will outline ACH Filter Debit specific functionality, and the third section will outline
ACH Filter Credit functionality.

Accounts enrolled in these services are assigned a default setting of System-Pay or System-Return. If a decision is not
made by the end of day cut-off time, the default setting will apply.

Three levels of notification and two alert types are supported, as well as customized notification rules. Approved and
blocked lists are available to automatically override the system default settings to automatically pay or return
transactions when they are received from companies identified on those lists. The approved and blocked lists are
designed to minimize unnecessary alerts and action when transactions are within pre-approved parameters.
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Notification Levels

When an account is enrolled for ACH Filter Credit or ACH Filter Debit, one of three levels of notification can be
established for exception alerts. The notification level options and descriptions are provided below. Email alerts are
standard. Customers can also elect to receive text alerts.

Notification Level

Description

One alert for each transaction.

Transaction Alerts
Account Alerts One alert per account when one or more transactions are received.
Service Alerts One alert per day if an exception exists on one or more accounts.

A. Using the Dashboard

Dashboard

The Dashboard is the default landing page within the portal. If ACH Filter Credit and/or ACH Filter Debit are
enabled, ACH Filter Credit/ACH Filter Debit summary box(es) will be displayed. Summary information on current
incoming ACH transactions and status will be displayed for accounts the user has been granted access. The user

must also have the Transaction History user privilege. Active links are embedded within the ACH Filter Credit and
ACH Filter Debit boxes to permit users to navigate from the dashboard landing page into the service modules or
directly to transactions in the status selected. Dashboard totals are updated in real time as transaction status

values are changed by a user.

The content displayed in the ACH Filter Credit and ACH Filter Debit summary boxes include the following:
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ACH Filter Credit

Total ACH Credits $10,674.98
Set to Pay $10,674.98

Approved List Exceptions $10,674.98
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End of Day Cut-Off Time: Thursday 12:00 PM EDT
(2] Pending Approval $0.00

(2] Set to Return $0.00

©00

(2] Block List Returns $0.00

Total ACH Debits $127,412.84
Set to Pay $0.00

Approved List Exceptions $127,412.8

ACH Filter Debit

End of Day Cut-Off Time: Thursday 12:00 PM EDT

@  Pending Approval $0.00 (0]
O  settoRetumn $127.412.84 D
4 @  Block List Returns $0.00 (0]

Service Name

End of Day Cut-Off
Time

Total ACH Debits /
Total ACH Credits

Approved List
Exceptions

Pending Approval

In the example provided, clicking ACH Filter Credit or ACH Filter Debit on the
left in the title bar will direct the user to the main menu. The service name may
vary by financial institution.

Displayed in the second bar, the day and time transaction decisions will be
collected by the financial institution. Some or possibly all transactions will be
ineligible for pay or return decisions after that time. If a pay or return decision
has not been made, the system pay or system return default will apply.

In the examples above, the total represents the total dollar amount and
number of incoming ACH debit transactions or ACH credit transactions received
by the Bank for the accounts the user has access to view.

This represents the total dollar amount and number of incoming ACH credit or
debit transactions received from companies that are not on the customer’s
approved list or have violated an approved list parameter.

If Dual Decision Approval has been enabled, the Pending Approval hyperlink will
appear in the Dashboard. Clicking on the dollar amount hyperlink on the
Pending Approval line will direct the user to the Debit or Credit Transaction
Approval Screen, where the user can approve or reject any transactions that are
pending approval by the user. For more information about Decisioning Dual
Approval, please refer to Section B-ll, Subsection C, Decision Dual Approval
(ACH Filter Debit) and Section C-ll, Subsection C, Decision Dual Approval (for
ACH Filter Credit).
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Block List Returns
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This represents the total dollar amount and number of incoming ACH credit or
debit transactions received from companies that are on the customer’s blocked
list and will be returned.

Total ACH Debits $127,412.84
Setto Pay

System

User

FI

Approved List

ACH Filter Debit

$0.00

Approved List Exceptions $127,412.84

End of Day Cut-Off Time: Thursday 12:00 PM EDT

@  Pending Approval $0.00 (0]
(0] Set to Return $127.412.84 @D

$0. (0]

$0 (0]

$0.00 0]

$0.00 [0
(11] Block List Returns $0.00 (0]

Set to Pay / Set to
Return

Transaction History

Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines
will expand the view to display a breakdown of the total for each category.
System Pay or Return indicate transactions that will pay or return if no action is
taken due to the default status. Users pay or return indicate a Customer user
decision has occurred. Approved List indicates the incoming ACH debits (ACH
Filter Debit) or incoming ACH credits (ACH Filter Credit) that are from
companies the customer has pre-approved to debit an account or accounts. The
status for these transactions will automatically be set to approved list pay. Fl
pay or return indicate an Fl decision has occurred on behalf of the FI.

The user can click on the dollar amount link for any category to be directed to a
filtered view of the Transaction History. In the examples below, the user has
clicked on the dollar value of debits under Set to Pay — System in ACH Filter
Debit and the dollar value of credits under Set to Pay — System in ACH Filter
Credit and is directed to a view of exception transactions that require decision.

Please refer to Section B. ACH Filter Debit for ACH Debits, Subsection Il.
Transaction History or Section C. ACH Filter Credit for ACH Credits, Subsection
Il. Transaction History, for more information on this function.



ACH Filter
User Guide

ik

Ach Filter Debit:

. i . Date Range
Debit Transaction History -
EAugust 6, 2020~
Y Filters ?
19 transactions totaling $43,590.62
R 1-190f19.
Date Company Account # Armount Current Status Manage
> 08/06/2020 Niveena's Natura 07678 $60.00  Pay- System
» 08/06/2020 Marshall Modelin X0XT7678 $1,042.00  Pay- System
> 08/06/2020 Leningrad Livery XOKT678 $8620 Pay-System
> 08/06/2020 Kelsey's Krafts XXXX7678 $768.00 Pay-System
> 08/06/2020 Justice Jeep Sal XOXKT678 $500.00  Pay-System
> 08/06/2020 Imojen's Ice Cre XXXXT678 $2,800.00  Return - User
» 08/06/2020 Hats on Heart 5t XXXTE7E $47.00  Pay- System
» 0B/06/2020 Garland Guesthou XXXXTETE $9.000.00 Pay - System
> 08/06/2020 Fine Felines Gro X0x7678 $100.00  Pay- System
ACH Filter Credit
g A 3 Date Range
Credit Transaction History -
ENovember 6, 2020~
Y Filters >
Date Company Account # Amount Current Status Manage
> 11/06/2020 Olivia's Omelett 001111 $3,200.00 Pay - System ® Reject
> 11/06/2020 Olivia's Omelett 01111 $3,200.00 Pay- System
> 11/06/2020 Niveena's Natura 30001111 $100.00 Pay-System
> 11/06/2020 Niveena's Natura 001111 $100.00 Pay- System
> 11/06/2020 Marshall Modelin xox1111 $47.00 Pay- System ® Reject
>  11/06/2020 Marshall Modelin 01111 $47.00 Return - User
> 11/06/2020 Leningrad Livery 00x1111 $2,800.00 Pay - System
» 11/06/2020 Leningrad Livery 01111 $2,800.00  Pay- System

From the Dashboard, a user can also navigate to the ACH Filter Debit or ACH Filter Credit Modules by clicking
Change Module > ACH Filter Debit or Change Module > ACH Filter Credit.
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age Users ol Reports = ransaction View Change Module -

— PRO-TECH CR
PRO-TECH

End of Day Cut-Off Time: Wednesday 4:00 PM EDT

B. Dashboard and Additional File Loads after EOD

After the end of day cut-off time, all pending ACH transactions are processed, and the Dashboard totals will clear
out. If additional ACH transaction files are loaded after the end of day cut-off time but prior to midnight, they
will not be displayed in the Dashboard until midnight and will be included in the next day’s totals.

Preferences

Preferences allow users to bypass the system default landing page and automatically place the user within the
service module and page to perform routine functions. For instance, a user may decide they want to
automatically land in the Transaction History page when entering the system, instead of going to the Dashboard
and clicking on Change Module and then Transaction History.

1. From within the Dashboard or ACH Filter Credit/ACH Filter Debit Module, click User’'s Name> Preferences.

ACH Filter Debit % Manage ~ # perform ~ sl Reports ~ 3= Transaction History Change Module ~ & Kristie Linder ~

=8 ABC Company

We I come »f preferences

© Logout

2. The Preferences page appears.

Preferences
Default Pages

Default Module

- select - v

Default Dashboard Page

- default - v

Default PRO-TECH Page

- default - hd

Save
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3. Default Module gives the User the ability to choose the default landing page.
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Preferences

Default Pages

Default Module

ACH Filter Debit v

- select -
Positive Pay
Dashboard
EDI TransAlert

ACH Filter Debit

ACH Filter Credit
- default - v

1. Default ACH Filter Credit/ACH Filter Debit page allows the user to select the default landing page within
the ACH Filter Credit/ACH Filter Debit.

2. Once any preferences have been selected, click Save to update the settings.

ACH Filter For ACH Debits

Itis important to note that ACH Filter Credit operates as a separate module and the functionality of that module is
explained in Section C., ACH Filter for ACH Credits. ACH Filter Credit will only be available if enabled by the Bank.

l. Notification Rules

Notification rules establish who should be alerted, how they should be alerted and the conditions that should
prompt an alert. Notification rules can be set on an account-by-account basis or all accounts can be configured
with the same notification rules. The two notification options are email and SMS text.

By entering a cell phone number for SMS text alerts, you are opting to receive text messages. Note that
additional fees from your carrier may apply. To opt out, simply remove the cell phone number from the user
interface and click Save.

A. Setup Notification Method and Condition
1. From the ACH Filter Debit Module, click Setup > Notification Rules

10
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£ Manage - # Perform = ali Reports - IE Transaction History Change Module -

[ Motification Rules |t
Approved List
| Block List

e use the above menu to select an action

2. The Manage Debit Notification Rules page appears. The Selection screen is the first screen of the
Notification Rules page and will display a list of all accounts that the user has access to.

moantacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected

FFFriends - xoox1111 *

FFF Payroll - x0omx2222 *

FFF Expense - xxxx3333 * -
FFF Escrow - xoocd444 *

*Accounts with default Notification Rules

= Next

NOTE: All accounts with the asterisk (*) symbol have not been configured, and have the default notification
rules, set up with the notification method via email. The email will be delivered to the default notification
contact established by the Bank, until such time the account is configured. The default notification condition is

to Notify for All ACH Debits.
3. Select the accounts to be configured and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Once all accounts have been selected, click the Next button to proceed.

11
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m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
FFF Payroll - xoo02222 * FFFriends - xoox1111 *
FFF Expense - xxx3333 * "

FFF Escrow - xxxx4444 *

*Accounts with default Notification Rules

—p =+ Next

4. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will allow
entry of up to 6 email addresses and up to 6 cell phone numbers for SMS text.

Selection Conditions Confirm

Enter the contact information to receive the ALERT

This account is currently set to send all notifications on all ACH debits to Tom Jones (Idelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 Cell Phone 4

Cell Phone 2 Cell Phone 5

Cell Phone 3 Cell Phone &
E-mail

Email 1 Email 4

Email 2 Email 5

Email 3 Email &

5. Toadd a cell phone number, enter the 10-digit cell number in the Cell Phone 1 field. Repeat this
process to add up to five additional cell phone numbers.

E-mail
Email 1 mhart@fffriends.com A 1 31 4
Email 2 fiones@fffriends.com Email 5
Email 3 | Email 6

12
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6. To add an email address, enter the email address in the Email 1 field. Repeat this process to add up to
five additional email addresses.

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-2402 Cell Phone 5
Cell Phone 3 ) Cell Phone 6

7. Once all cell phone numbers and email addresses have been added, the user can proceed to the next
step by clicking the Next button. Clicking the Next button saves the data and moves to the next step.
The user can click the Back button to go back to the Selection page, but the user will lose all data
entered on this screen.

Selection Conditions Confirm

Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH debits to Tom Jones (lIdelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-2402 Cell Phone 5
Cell Phone 3 Cell Phone 6
E-mail
Email 1 mhart@fffriends.com Email 4
Email 2 fiones@fffriends.com Email 5
Email 3 Email 6
+« Back = MNext

8. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can
define the criteria for when alerts should be sent. It is important to note that the alert criteria controls
the alerting process but does not control the transaction status designated at load time. The
transaction status is controlled by the default setting, approved and block list settings. Only one radio
button can be selected.

13
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Selection Contacts EeLGIEHEN Confirm

o  Notify for all ACH Debits

Notify only when an ACH Debit is over

+ Back

Notify anly when an ACH Debit meets one or more of the following criteria
The ACH Debit was created from a payment made by check
The ACH Debit was created from a payment over the Internet
The ACH Debit was created from a payment over the phone

Notify only when an ACH debit is received from a Company not on the Approved List or does not meet the parameters on the Approved List

Select a condition to receive the Alert

=+ Next

Notify for all ACH Debits

Notify only when an
ACH Debit is over

Notify only when an
ACH Debit meets one or
more of the following
criteria

Notify only when an
ACH Debit is received
from a Company that is
not on the Approved
List or does not meet
the parameters on the
Approved List

An alert will be sent for every ACH debit received on the accounts
configured with this notification condition.

Enter the dollar amount.

Alerts will only be sent when an ACH Debit is received that is
greater than the dollar amount established.

Alerts will not be sent when an ACH Debit is received that is equal
to or less than the dollar amount established.

An alert will be sent for the criteria selected.
Select one, two or all three criteria:

Payment was made by check and converted into an ACH entry
(includes transactions with an ARC, BOC, POP, or RCK standard
entry class code).

Payment from a bank account was authorized over the internet
or on a mobile phone (includes transactions with a WEB standard
entry class code).

Payment from a bank account was authorized over the telephone
(includes transactions a TEL standard entry class code).

An alert will be sent only when an ACH debit is received on the
account from a company not set up on the approved list or is set
up on the approved list but violates one of the additional
parameters set, such as maximum amount, frequency, or start or
end date.

Alerts will NOT be sent on ACH debit transactions that are
received from companies set up on the approved list and are

14
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within approved list parameters. Those transactions will receive
a status of approved list pay. However, the status can be
changed from within Transaction History.
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9. Click Next to go to the Confirm page. Review all the information entered, and if correct, click the Save
button. If changes need to be made, click the Back button to navigate back to the appropriate screen.

Selection Contacts Conditions geailg]

Confirm Notification Rules

Account(s) Selected
X001 111, X002222, 30003333, 0004444
Cell Phone Text

Cell Phone 1: 5554443333 Cell Phone 4:

Cell Phone 2: 8182099402 Cell Phone 5:

Cell Phone 3: Cell Phone &:
Emails

Address 1: mhart@fffriends.com Address 4:

Address 2: fjones@fffriends.com Address 5:

Address 3: Address 6:

Notification Condition

Condition: Notify for all ACH Debits

Save

+ Back

10. Once Save has been clicked, a success message will appear.

Selection Contacts Conditions

W Notification Rules have been configured successfully

11. If the default notification rules have been changed, the account will no longer have an asterisk (*).
12. If the user would like to restore the default contact and conditions, they may do so by navigating to the

Contacts screen, where there will now be an option to select a checkbox to use default contact and
conditions.

15
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Selection Conditions Confirm

Enter the contact information to receive the ALERT

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4

Cell Phone 2 (818) 209-9402 Cell Phone 5

Cell Phone 3 Cell Phone 6
E-mail

Email 1 mhart@fffriends.com Email 4

Email 2 fiones@fffriends.com Email 5

Email 3 Email 6

Use Default Contact and Conditions -

+ Back - Next

Transaction History

Transaction History allows authorized users to search and view all ACH debits that have been received on
enrolled accounts, and to make decisions on items. Users can use Transaction History to search for ACH
transactions for a specific account using one of the many filtering options available.

A. View Transaction History

Transactions are available in transaction history for one (1) year.

The Transaction History user privilege must be enabled to access this screen.

If the user has been granted the Change Status user privilege and the transaction is available to
decision, the Pay and Return buttons will be available for use.

Transactions that will be paid will have green shading as a background.

Transactions that will be returned will have yellow shading as a background.

Transaction in a return status cannot be changed after the EOD cut-off time.

1. There are two ways to navigate to the Transaction History page. One option is to navigate directly to ACH
Filter Debit Transaction History from the Dashboard, by clicking on any dollar amount displayed within the
ACH Filter Dashboard. When using this option, Transaction History will only display transactions included in
the category selected. To see all transactions, click on Total ACH Debits.

Another option is to navigate within the ACH Filter Debit module, to the View menu and click Transaction
History.

16
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ACH Filter Debit % Manage ~

# Perform -

il Reports ~

Welcome

Please use the above menu to select an action

i= Transaction History

2. The Transaction History page will display all current day transactions for all accounts to which the user has

access.

Y Filters

Date

> 08/06/2020

> 08/06/2020

> 08/06/2020

> 08/06/2020

> 08/06/2020

> 08/06/2020

> 08/06/2020

Debit Transaction History

Company

Niveena's Natura

Marshall Modelin

Leningrad Livery

Kelsey's Krafts

Justice Jeep Sal

Imojen's Ice Cre

Hats on Heart St

19 transactions totaling $43,590.62

Account #

X767 8

Xxx7678

XxXxx7678

XXXXT678

WXT6T8

Xxxx7678

XXxx7678

Rows1-1

90f19,

Amount

$60.00

$1,042.00

$86.20

$768.00

$500.00

$2,800.00

$47.00

Current Status

Pay - System

Pay - System

Pay - System

Pay - System

Pay - System

Return - User

Pay - System

Date Range
HAugust 6, 2020 ~
>

Manage

® Return
@® Return
@® Return
@ Return
® Return

@ pay

® Return

Date

Company

Account Number

Amount

Date the ACH debit was presented for payment or loaded to ACH Filter.

Name of the company debiting the account. This information is obtained from the
company name field in the batch header record of the ACH transaction.

Account number the ACH debit was presented against.

Amount of the ACH debit.

17
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Current Status

Status

Pay

Pay-System

Pay-User

Approved List-
Pay

Pending-Pay
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Description Change Allowed Until

Transactions that load with Return deadline,
this status indicate the account type and
default condition transaction type.
established by the Bank is

to pay all transactions on

this account if users take

no action.

Indicates a user has Return deadline,
changed the status of a account type and
transaction from Return to  transaction type.
Pay.

Transactions that load with  Return deadline,
this status indicate the
company that originated
the transaction was set up
on the approved list for this
account prior to receipt of
the transaction and the
transaction amount,
frequency and date are
within the allowable
parameters specified in the
approved list entry.

account type and
transaction type.

Indicates a user has
changed the status of the
transaction from Return to
Pay, but the decision must
be approved by a
secondary user because
Decision Dual Approval has
been enabled.

Return deadline,
account type and
transaction type.

18
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Pay-Fl

Pay-Fl Charge

Return-System

Return-User

Block List-
Return

Return-Fl

Indicates Bank user has
changed the status of a
transaction from Return to
Pay.

Indicates a transaction for a
Company ID that is on the
Bank Return Override List
and the status cannot be
changed from Pay to
Return.

Transactions that load with
this status indicate the
default condition
established by the Bank is
to return all transactions on
this account if users take
no action.

Indicates a user has
changed the status of a
transaction from Pay to
Return.

Transactions that load with
this status indicate the
company that originated
the transaction was set up
on the blocked list for this
account prior to receipt of
the transaction.

Indicates an Bank user has
changed the status of the
transaction from Pay to
Return.

A T1 N

Return deadline,
account type and
transaction type.

No changes to this
status are allowed.

Up until EOD cut-off
time.

Up until EOD cut-off
time.

Up until EOD cut-off
time.

Up until EOD cut-off
time.

19
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Manage If the user has been granted the Change Status user privilege and the transaction is eligible for
a decision, a Pay or Return button will appear for use. If the transaction is not eligible for a
decision, (because the return deadline or end of day cut-off time has passed) the button will
display as ineligible.

a. Tofilter the date range of items shown, click o the Date Range drop-down.

Date Range

Debit Transaction History WAugust 6. 2020~

Y Filters Tomorro
Date Company Account # Amount Current Status
> 08/06/2020 Niveena's Natura XXXX7678 $60.00 Pay - System
> 08/06/2020 Marshall Modelin XXXX7678 $1.04200 Pay-System
> 08/06/2020 Leningrad Livery XXxx7678 $86.20 Pay- System

b. To narrow the search results, click Filters and a window containing additional search criteria will appear.

‘ . . DateR
Debit Transaction History ate range

i@September 15, 2021+

Y Filters v
Account’ Company’ Transaction Status
- not selected - v . 3 OF Pay
Pay - System
Min Amount Pending Approval Pay - User
Approved List Pay
5 Show All ~ Pay - I
Pay - FI Charge
Max Amount Return
$ * Return - System
Return - User
Return - FI
Block List Return
" key to select multiple status
Account Type an account name or the last 4 digits of the account number into the field to view
transactions for one specific account or select an account from the drop-down menu.

Min To search for a transaction by amount within a minimum/maximum range, type the

Amount / minimum and/or maximum dollar amount(s) of the transactions into the appropriate

Max field.

Amount

Companies Enter a specific company name.

20
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If the Bank has enabled Decision Dual Approval, this field may be available in the filter
window. The user may select from the drop-down to filter transactions based on
whether or not they are pending approval.

Pending
Approval

Transaction
Status

Yes — will display only transactions that are pending approval.
No — will display only transactions that are not pending approval

The default will be set to “Show All”. For more information regarding Decision Dual
Approval, please see Subsection C, Decision Dual Approval, below.

See #2 in this subsection for definitions of the different transaction statuses.

c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the results will
be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all results.

e. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The information
shown in this drop-down is an audit history of all the activity that has occurred on the issue item.

Debit Transaction History

Y Filters

Date Company

Del Alre Develop

<

03/10/2021 Del Alre Develop

Account: WKP M:

Transaction

Individual Name: Del Aire Developers

Date Range

WMarch 10, 2021
>

Account # Amount Current Status Manage

SEC Code: PPD Add to Approved List | Add to B

X011 5270000 Pending-Pay

0001111 5270000  Pay-System

Desa

Trace #: 064208470003748

Company ID: D00008

001111 $2.700.00  Return - User
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Account

Transaction ID

Individual Name

SEC Code

Description

Trace #

Company ID

Add to Approved
List

Add to Block List

Download WSUD

Deadline to
Pay/Return

The account name and last 4 digits of the account number.

Unique ID assigned by the ACH Filter Debit system when transactions are
loaded.

Name of the payee/recipient found in the individual ID field of the incoming
ACH transaction.

Standard entry class code. Reference the NACHA Rule Book for SEC code
descriptions. SEC codes are generally used to classify transactions by the way
they were authorized.

The description used by the originator of the transaction, as contained in the
company batch header record for the transaction received.

A unique ID assigned to the transaction by the originator, ACH operator or
receiving depository financial institution.

A unique identifier for the company that originated the ACH debit. This
information is obtained from the company ID field of the batch header record
of the ACH transaction. This unique identifier is used to match transactions to
approved or blocked list entries.

Will only appear if the user has Act on Approved list user privilege. Please refer
to Subsection lll, Approved List within this Section for more information about
this feature.

Will only appear if the user has Act on Blocked list user privilege. Please refer to
Section IV, Blocked List within this Section for more information about this
feature.

Option to download a PDF copy of an electronic written statement of
unauthorized ACH Debit signed by the user when returning an ACH debit that
required the dispute form.

Deadline to change the status of any transaction from Pay to Return or from
Return to Pay.

A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the bottom of

the Transaction History screen.
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1. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a

A T1 N

decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision, the

button will display as ineligible

2. Change Status — Pay

a. If the Current Status on an issued item is set to Return, the Customer can opt to change the status

to Pay if the Customer determines the debit transaction should be paid.

b. Click the Pay button under the Manage Column.

Date

> 08/06/2020

> 08/06/2020

> 08/06/2020

> 08/06/2020

Company

Niveena's Natura

Marshall Modelin

Leningrad Livery

Kelsey's Krafts

Account #

XXXX7678

XXXX7678

XXXX7678

XXXX7678

Amount

$60.00

$1,042.00

$86.20

$768.00

Current Status

Pay - System

Pay - System

Return - User

Pay - System

Manage

® Return

® Return

(©} Pay

IR

® Return

c. A success message will appear temporarily in the Manage column, with an option to Add to

Approved List. This link will only appear if the user has the Act on Approved List user privilege. The
user can click the hyperlink embedded in that option to proceed to Add to Approved list. If the user

does not opt to Add to Approved list at this time, the option is still available under the expanded
view of this debit item.

Date

> 08/06/2020

> 08/06/2020

> 08/06/2020

Company

Niveena's Natura

Marshall Modelin

Leningrad Livery

Account #

XXXX7678

XXXX7678

XXXX7678

Amount

$60.00

$1,042.00

$86.20

Current Status

Pay - System

Pay - System

Pay - User

Manage

Debit will be paid.
4 Add to Approved List

d. After afew moments, the Change Status button will then change to Return, and the Current Status
column will update to “Pay-User.”

Date

¥ 08/06/2020

¥ 08/06/2020

> 08/06/2020

Company

Niveena's Natura

Marshall Modelin

Leningrad Livery

Account #

XXXXT678

XXXX7678

XXXX7678

Amount

$60.00

$1.042.00

$86.20

Current Status

Pay - System

Pay - System

Pay - User

Manage

® Return

® Return

@ Return
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3. Change Status — Return

a. Ifthe Current Status on an issued item is set to Pay, the Customer can opt to change the status to
Return if the user determines the debit transaction should be returned.
b. Click the Return button under the Manage column.

Date Company Account # Amount Current Status Manage
> 08/06/2020 Niveena's Natura XXXXT678 $60.00  Pay- System ¢
> 08/06/2020 Marshall Modelin XXXX7678 $1,042.00 Pay- System
> 08/06/2020 Leningrad Livery XXXX7678 $86.20 Pay- User
> 08/06/2020 Kelsey's Krafts XT678 $768.00 Pay- System

c. A success message will appear temporarily in the Manage column, with an option to Add to Block
List. This link will only appear if the user has the Act on Block List user privilege. The user can click
the hyperlink embedded in that option to proceed to Add to Block list. If the user does not opt to
Add to Block List at this time, the option is still available under the expanded view of this debit
item.

It is important to note that if a Written Statement of Unauthorized Debit is required, the Add to
Block List hyperlink will not appear, as the Written Statement of Unauthorized Debit will pop-up
instead. In this case, the user must expand the view of the debit item to Add to the Block List.

Date Company Account # Amount Current Status Manage
» 08/06/2020 Niveena's Natura XXXXT678 $60.00  Return - User Debit will be returned
+ Add to Block List
>  08/06/2020 Marshall Modelin WOTETE $1,042.00 Pay- System

d. About Written Statements of Unauthorized Debits: All returns will be given an R29 return reason
code regardless of the SEC code of the transaction. This behavior is consistent with how ACH debit
blocks/filters work today.

C. Decision Dual Approval

ACH Filter Debit offers the ability to support dual approval for user decisioning. If User has decisioned any
transaction in the Transaction History to the status of Pay, the transaction will be listed as Pending-Pay and
an alert message will be sent via email and/or SMS text message requesting the approval of the change of
the transaction status. The secondary user must approve the transaction decision.
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1. Within the ACH Filter Debit module, click Perform > Transaction Approval.

ACH Filter Debit #¥Manage~ | #Perform~  WiReports » = Transaction History

Transaction Approval

Welcome

Please use the above menu to select an action

2. The Debit Transaction Approval screen will display.

Debit Transaction Approval
Rows1-2aof 2.
Select
Lall | none] Date Company Account # Amount Current Status Requested Statusli
? O 03/10/2021 Del Aire Develop 001111 $2,700.00 Return - User Pay
> O 03/10/2021 Del Aire Develop 001111 $2,700.00 Return - User Pay
Selected
Select [all | none] The user can opt to select individual transactions by clicking the
checkbox at the left of the row. The user can also select all
transactions by clicking “all” in the Select column. The user can
de-select all transactions by clicking “none”.
Date Date of the transaction.
Company Name of the company debiting the account.
Account Number Displays the masked account number for the item.
Amount Amount of the debit transaction.
Current Status Current status of the transaction.
Requested Status The status of the transaction, if approved.
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3. Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information
about the transaction.

Select
Lall | none] Date Company Account # Amount Current Status ReqUEStEd Statusli
hd O 03/10/2021 Del Aire Develop 2001111 $2,700.00 Return - User Pay

Transaction ID: 73189120
Requested By: FFFTomjones

Transaction ID Unique ID assigned by the ACH Filter Debit system when

transactions are loaded
Requested By The user who has requested the change of transaction status.

4. After examining the transactions pending approval, the user can select items to approve or deny by
clicking the Approve or Deny buttons at the bottom of the screen.

5. Ifatransaction is Approved, a Confirm Approval pop-up window will appear. The user can click the
Confirm button to confirm the approval of the transaction status change or click the Cancel button to
return to the Debit Transaction Approval Screen.

Confirm Approval

Approve status change of 1 transaction

Click Cancel to return or Confirm to continue

6. If atransaction is Denied, a Confirm Rejection pop-up window will appear. The user can click the
Confirm button to confirm the rejection of the transaction status change or click the Cancel button to
return to the Debit Transaction Approval Screen.

Confirm Rejection

Reject status change of 1 transaction

Click Cancel to return or Confirm to continue

Cancel Confirm
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NOTE:

It is important to note that if a transaction decision is currently awaiting approval from a secondary
user and the transaction is not approved or rejected by EOD, the transaction will revert to its original
status. For instance, if a transaction is set to default return and a user decisions the item to be paid, if
that decision is not approved by EOD, the item will revert to the default return status.

Approved List

The Approved List allows Customers to identify companies that are allowed to debit an account or accounts and
set parameters to control the debit activity. There are multiple ways to populate the approved list. It can be
done through the Setup > Approved List menu option, or users can add companies to the approved list from
Transaction History. It is important to note that companies added from Transaction History will only be added to
the account associated with the transaction it was added on. To allow the company to debit other accounts, the
user must edit the approved list.

Users can edit and delete companies from their approved list.

The way ACH Filter Debit identifies approved companies is by verifying the company ID ONLY in the batch
header record of the incoming ACH transaction is an exact match. If an exact match is found, if additional
parameters have been established such as maximum amount, frequency, start/end date, the values found in the
ACH batch/transaction are compared to the list to determine if an alert is required and the transaction status
that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the approved list is
shown below.

Verifies Company ID

101 026013262 0642085182008060550A094101Delacse Bank & Trust  FRB Atlanta
5200ashland Armament PEDPTTest0820 200806  1064208470000031
6220260132627677677678 0000150000200008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000200008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000 0008 064208470000031
5200Biolab Birmingha B00008|  PEDPTTest0805 200806  1064208470000032
6220260132627677677678 0000130000500008 Biolab Birmingham 0064208470000395
6270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
820000000200052026520000002500000000001 30000800008 064208470000032
5200Cartwright Car S co0008]  eeDETTEst0BOE 200806  1064208470000033
6220260132627677677€78 0000800000C00008 Cartwright Car Sales  0064208470000397
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop DO0008  PEDPTTest0804 200806  1064208470000034
6220260132627677677678 0000170000D00008 Del Aire Developers 0064208470000398
6270260132627677677678 0000270000D00008 Del Aire Developsrs 0064208470000399
82000000020005202652000000270000000000170000D00008 064208470000034
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Compares against Maximum Amount Parameter

101 026013262 0642085182008060550A094101DeLaere Bank & Trust FRB Atlanta

5200Ashland Armament AQ0008 PPDPTTest0820 200806 1064208470000031
6220260132627677677€78 0000150000400008 Ashland Armament 0064208470000393
€270260132627677677678 0000030000200008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000150000A00008 0€64208470000031
5200Biclab Birmingha BO0O0OOS PPDPTTest0805 200806 1064208470000032
6220260132627677677678 0000130000p00008 Biolab Birmingham 0064208470000395
6270260132627677677678 0000250000p00008 Biolab Birmingham 0064208470000396
82000000020005202€52000000250000000000130000B00008 064208470000032

Compares against Frequency and Start/End Date Parameters

101 026013262 0642085182008060950A094101DeLacre Bank & Trust  FRB Atlanta
5200Ashland Armament 200008 PPDPTTest0820 1064208470000031
6220260132627677677678 0000150000A00008 Ashland Armame 0064208470000393
6270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000150000A00008 ; 064208470000031
5200Biolab Birmingha B00008 PPDPTTest0805 200806| 1064208470000032
6220260132627677677678 0000130000B00008 Biolab Birmingham 0064208470000395
6270260132627677677678 0000250000800008 Biolab Birmingham 0064208470000396
82000000020005202652000000250000000000130000B00008 064208470000032

If the notification criteria is set to Notify when a debit comes in from a company not on the approved list or
violates approved list parameters, ACH Filter Debit will alert designated contacts when a debit is received from
an unknown company or from a company that is set up, but violated the parameters. If notification criteria are
set to all debits, debits over a certain amount or certain types of debits, the system will NOT alert for approved
list violations. If the transaction meets approved list criteria, it will receive a status of Approved List-Pay. If it
does not, it will receive the system default status.

A. Add to Approval List From Setup Menu

1. Within the ACH Filter Debit module, click Manage > Approved List.

ACH Filter Debit = #¥Manage ~  # Perform ~  JiReports ~  i= Transaction History

Notification Rules

Approved List

Block List Welcome

Please use the above menu ta select an action
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2. The Debit Approved List will display. Click the Create button to add an entry to the Approved List.

+ Create —

Company ID ¢
Delete

@ Delete Selected

Company Name 3

Approved List

Maximum Amount Frequency

O ACME Acme Widget

$20.000.00

Start Date

06/18/2020

End Date Edit
Edit

@ Cancel

3. The Add Company page will display. Complete all applicable fields in the top section of the screen.

Approved Company

Company Detail

Company ID
Max Amount

Start Date

Add Accounts to Approved List

06/18/2020

FFF Escrow - xoocd444
FFF Expense - xxx3333
FFF Payroll - xox2222
FFFriends - ooxx1111

Company Name
Frequency
End Date

=

~ Save | @ Cancel

No Frequency -

ik

29



ACH Filter
User Guide

2T N

Field Name

Optional or
Required

Field Validated

Field Content

Notes

Company ID

Required

Exact Match

Max: 10

Valid Characters:

A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

Company Name

Optional

Not Validated

Max: 16

Valid Characters:

A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

Max Amount

Optional

e The transaction meets

the parameters when
the amount the
amount is less than or
equal to the Max
Amount

e The transaction does
not meet the
parameters when the
amount is greater than
the Max Amount.

e Blank: Any amount

is accepted and will
not trigger an alert.

e Zero: Will not be
accepted and entry
will not save to
Approved List.

e Highest amount:
$99,999,999.99

Valid Characters:

0-9
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Field Name Optional or Field Validated Field Content Notes
Required
Frequency Optional If multiple transactions | e Daily: 1 business Counter:
are on a file, the sort day
order is highest to e Weekly: 7 calendar | The counter begins with
lowest dollar value. days the first transaction
If the transaction with | ¢ Bi-Weekly: 14 received after the
the highest dollar value calendar days Company and Account is
exceeds the Maximum | ¢ Monthly: Monthly added to the Approved
Amount, all date-to-date List regardless if the
transactions on the file | e Quarterly: transaction meets or
are not approved. Quarterly date-to- does not meet the
If the transaction with date parameters of the
the highest dollar value | e Yearly: Yearly date- | APProved List.
is equal to or less than to-date
the Maximum Amount,
that transaction is Date-to-Date
approved and all other | Exceptions:
transactions on the file | o Non-Leap Year
are not approved. January 29, 30, 31:
February 28
e Leap Year January
30, 31, February 29
e March 31: April 30
e May 31:June 30
e August31:
September 30
e October 31:
November 30
Start Date Required The transaction meets | The Start Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.
after the Start Date.
The transaction does
not meet the
parameters when the
date is before the Start
Date.
End Date Optional The transaction meets | The End Date is based | Valid Characters:
the parameters when on the settlement 0-9
date.
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Field Name Optional or Field Validated Field Content Notes

Required

the date is equal to or
before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

4. Choose from the list of available accounts to add to the Approved List.
> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Approved List

FFF Expense - 003333 FFF Escrow - xooxd444

FFF Payroll - xxxx2222
FFFriends - 01111

~ Save @ Cancel

5. Once the entry is completed, click Save to save it to the Approved List. A success message will appear.

&) Approved Company Saved Successfully

+ Create

Approved List
CompanyID ¢ Company Name ¢
Delete Maximum Amount Frequency Start Date End Date Edit
B ) ACME Acme Widget $20,000.00 06/18/2020 Edit
TJONES1 Tom Jones $50.000.00 MONTHLY 06/18/2020 Edit

® Delete Selected @ Cancel

6. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be
taken to the Company’s screen.
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7. Todelete any entity on the Approved list, click the checkbox next to the appropriate row, and click the
Delete Selected button.

B. Add to Approved List from Transaction History

8. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Date

> 08/06/2020

v 08/06/2020

Account: Client 8 Main xxxx7678
Transaction ID: 73179127

Individual Name: Marshall Modeling

Company Account #
Niveena's Natura XHXXTETE
Marshall Modelin 20007678

SEC Code: PPD
Description: PTTest0814
Trace #: 064208470000436

Amount Current Status

$60.00 Return - User

$1.042.00 Pay - System

Company ID: MO0008

Add to Approved List Add to Block List

Deadline To Return: 10/03/2020 4:00 PM EDT

Manage

9. Click the Add to Approved List button to add a company. The Add Company pop-up window will

Add Company to Approved List

appear.

record of the transaction received.

Company Id Company Name Start Date End Date
M00008 Marshall Modelin &  08/06/2020 &
Max Amount Frequency
1042 - none -- v
Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header

Company Name Populated with the company name data from the batch header v
record of the transaction received.

Max Amount Populated with amount of transaction received. v

Frequency Left blank. v

Start Date Populated with the date of transaction received. v

End Date Left blank v

33



ACH Filter
User Guide

10. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History without
adding to the Approved List.
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11. The user will be directed to the Transaction History page once the company has been added to the
Approved List.

C. Approved List Failure Reasons

When a transaction exception is triggered because of Approved List parameters, the system default status
will apply. Examples of types of failure reasons are listed below.

Reason Description Sample
Transaction Dollar amount of transaction is Current Status Manage
Amount is greater than the maximum amount
. ; Pay- S
Greater than in the Approved List entry. B
Approved List
Add to Approved List Add to Block List
Amount
Deadline To Return: 08/16/2020 5:00 PM EDT
Approved List Violation: Transaction Amount: 1500 is greater than Approved
List amount: 1000
Frequency Transaction violates the frequency
Failure set in the Approved List entry. S
Add to Approved List Add to Block List
Deadline To Return: 10/03/2020 4:00 PM EDT
Approved List Violation: Frequency: YEARLY Last Transaction Date:
06-AUG-20
Out of Date Transaction was presented prior to
Range the Start Date or after the Ending Pay - System

Date of the Approved List entry.

Add to Approved List Add to Block List

Deadline To Return: 08/13/2020 5:00 PM EDT
Approved List Violation: Out of Date range - Start Date: 18-JUN-20 End Date:
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IV. Blocked List

The Blocked List is an optional feature which, allows Customers to identify companies that are NOT allowed to debit an
account or accounts. There are multiple ways to populate the blocked list. It can be done through the Setup > Blocked
List menu option, or users can add companies to the blocked list from Transaction History. It is important to note that
companies added from Transaction History will only be added to the account associated with the transaction it was
added on. To prevent the company from debiting other accounts, the user must edit the blocked list.

Users can edit and delete companies from their blocked list.

If an exact match is found, if additional parameters have been established such as start or end date, the values found in
the ACH batch/transaction are compared to the list to determine if an alert is required and the transaction status that
should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the blocked list is shown

below.

Verifies Company ID

101 026013262 0642085182008060550A0541Q1D=La Bank & Trust  FRB Atlanta

5200Ashland Armament W PPDPTTest0820 200806 1064208470000031
6220260132627677677678 0000150000A00008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000150000A00008 064208470000031
5200Biolab Birmingha PPDPTTest0805 200806 1064208470000032
6220260132627677677678 0000130000B00008 Biolab Birmingham 0064208470000395
6270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
820000000200052026520000002500000000001,30000800008 064208470000032
5200Cartwright Car S PPDPTTest0806 200806 1064208470000033
6220260132627677677678 0000800000C00008 Cartwright Car Sales 0064208470000397
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop D00008 PPDPTTest0804 200806 1064208470000034
6220260132627677677678 0000170000D00008 Del Aire Developers 0064208470000398
6270260132627677677678 0000270000D00008 Del Aire Developers 0064208470000399
82000000020005202652000000270000000000170000D00008 064208470000034

Compares against Start/End Date Parameters

101 026013262 06420851820080609502094101DeLaere Bank & Trust FRB Atlanta

5200Ashland Armament A00008 PPDPTTest0820 200806 1064208470000031
6220260132627677677678 0000150000A00008 Ashland Armament 0064208470000393
62702€0132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000150000A00008 064208470000031
5200Biolab Birmingha B00008 PPDPTTest0805 200806 1064208470000032
6220260132€276776776€78 0000130000B0000S8 Biolab Birmingham 006420847000039S
6270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
82000000020005202652000000250000000000130000B00008 064208470000032
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Blocks are intended to automatically return items and alerts are not sent out. However, Customers can see those items
in transaction history and have the option to pay them before EOD cut-off time. The dashboard will be updated in the
next release to display blocked item summary information.

A T1 N

A. Add to Blocked List from Setup Menu

1. Within the ACH Filter Debit module, click Setup > Blocked List.

ACH Filter Debit = #Manage~  # Perform~  JiReports ~ i Transaction History

Maotification Rules

Approved List
Block List ‘ WEICome

Please use the above menu to select an action

2. The Debit Block List will display. Click the Create button to add an entry to the Block List.

+ Create ¢
Block List
CompanyID ¢ Company Name &
Delete Start Date End Date Edit
O SKETCH Sketchy Corp 06/19/2020 Edit
@ Delete Selected @ Cancel

3. The Add Company to Debit Block List page will display. Complete all applicable fields in the top section of the

screen.
Blocked Company
Company Detail
Company ID Company Name
Start Date 06/19/2020 End Date

Add Accounts to Block List

FFF Escrow - 0004444
FFF Expense - xox3333
FFF Payroll - xxxx2222
FFFriends - xoox1111

~ Save @ (Cancel
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the parameters when
the date is equal to or
before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

on the settlement
date.

Field Name Optional or Field Validated Field Content Notes
Required
Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
Start Date Required e The transaction meets | The Start Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.
after the Start Date.
e The transaction does
not meet the
parameters when the
date is before the Start
Date.
End Date Optional e The transaction meets | The End Date is based | Valid Characters:

0-9
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4. Choose from the list of available accounts to add to the Approved List.

A T1 N

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Block List

FFF Expense - 0003333 FFF Escrow - xooodd44

FFF Payroll - xxxx2222
FFFriends - 0001111

~ Save Cancel

5. Once the entry is completed, click Save to save it to the Blocked List. A success message will appear.

W) Blocked Company Saved Successfully
+ Create
Block List

Company ID ¢ Company Name &
Delete Start Date End Date Edit
O MAX, Maximum Focus 06/19/2020 Edit
O SKETCH Sketchy Corp 06/19/2020 Edit
@ Delete Selected @ Cancel

6. To edit any entity on the Blocked List, click the Edit hyperlink at the end of the appropriate row to be taken to
the Company’s screen.

7. Todelete any entity on the Blocked list, click the checkbox next to the appropriate row, and click the Delete
Selected button.

B. Add to the Blocked List from the Transaction History

1. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.
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Date Company Account # Amount Current Status Manage
¥ 08/06/2020 olivia's Omelett XXXXT678 $800.00  Pay- System
v 08/06/2020 Marshall Modelin XXXX7678 $1,042.00 Pay- System
Account: Client 8 Main 007678 SEC Code: PPD Add to Approved List | Add to Block List
Transaction ID: 73179127 Description: PTTest0814 .
Deadline To Return: 10/03/2020 4:00 PM EDT
Individual Name: Marshall Modeling Trace #: 064208470000436
Company ID: MOD0O08

2. Click the Add to Blocked List to add a company. The Add Company pop-up window will appear.

Add Company to Block List

Company Id Company Name Start Date End Date

MO00008 Marshall Modelin &  08/07/2020 =

Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header
record of the transaction received.
Company Name Populated with the company name data from the batch header v
record of the transaction received.
Start Date Populated with the date the transaction was received. v
End Date Left blank v

3. Click the Save button to add to Block List. Click Cancel to return to the Transaction History without adding to

the Block List.
4. The user will be directed to the Transaction History page once the company has been added to the Block List.

C. Block List Failure Reasons

When a transaction exception is triggered because of Block List parameters, the system default status will apply.
Examples of types of failure reasons are listed below.
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Reason Description Sample

Out of Date Transaction was presented prior to

Range the Start Date or after the Ending Block List Return L
Date of the Approved List entry. @ Ineligible

Add to Approved List Add to Block List

Blocked List Violation: Account on Blocked List

V. Reports
Reports are available for one (1) year.
A. Notification Rules Report

The Notification Rules report provides authorized users a method to view the notification conditions
set for each account enrolled for the service. The report allows users to see the default account
setting established by the Bank, as well as the notification condition and contact information
established by the Customer.

1. Within the ACH Filter Debit Module, click Reports > Notification Rules Report.

£ Manage = & Perform = i Reports - i= Transaction History
Approved List
Block List
FEICDI ne | motification Rules Report |
se use the above menu to select an action

2. The Notification Rules Report page appears.
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Account Number

X111

XXXX2222

XXxx3333

xxxx4444

Account
Setting

Pay All

Pay All

Pay All

Pay All

Notification Conditions for Client 3
Nonﬁcva‘non Amount Check Internet Phone Email Cellphone
Condition
1. mhart@fffriends.com 1. 5554443333
2. fiones@fffriends.com 2. 8182099402
s 3. 3.
Al
Il Debits & 1
L¥ 5
6. 6.
1. mhart@fffriends.com 1. 5554443333
2. fiones@fffriends.com 2. 8182099402
> 3. 3.
A
| Debits 4 4
5 S
6. 6.
1. mhart@fffriends.com 1. 5554443333
2. fiones@fffriends.com 2. 8182099402
3, 3.
All Debits a a
5 5.
6. 6.
1. mhart@fffriends.com 1.5554443333
2. fiones@fffriends.com 2. 8182099402
i 3. 3.
All Debits 4 4.
5. 5.
6. 6.
Total count: 4

Account Number

Account Setting

Notification Condition

Debit Amount

Check

Internet

Phone

Email

Cell Phone

The last 4 digits of each account number enrolled.

The default pay or return setting established by the financial institution when the account
was enrolled for the service.

o Pay All

o Return All

See Notification Rules section for detailed descriptions:
o All Debits

o Debit Over the Debit Amount

e Company Not in Approved List

If Notification Condition is Debit Over the Debit Amount, the amount entered will be
displayed.

If Notification Condition is ACH Debits with Check/Internet/Phone is selected
If Check is selected, Y will be displayed.

If Notification Condition is ACH Debits with Check/Internet/Phone is selected
If Internet is selected, Y will be displayed.

If Notification Condition is ACH Debits with Check/Internet/Phone is selected
If Phone is selected, Y will be displayed.

Email address(es) that will receive email alerts.

Cell phone number(s) that will receive email alerts; this section will display only if the
financial institution is configured to allow SMS Text alerts.
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B. Approved List Report

The Approved List report makes it easy for users to identify all the companies set up on the approved list for a
specific account.

1. Within the ACH Filter Debit Module, click Reports > Approved List.

£ Manage - # Perfe

erfonm = i Reports - = Transaction History
| Approved List | —
Block List
fEICOI ne Motification Rules Report
se use the abowe menu to select an action
2. The Approved List Report page appears.
Approved List
Account: -All - ¥
Search Cancel
Approved List
Company ID ¢ Company Name ¢ Maximum Amount ¢ Frequency ¢ Start Date ¢ End Date ¢ Action
ACME Acme Widget $20,000.00 YEARLY 06/18/2020 View

3. The Account drop-down menu will allow the user to search approved list entries by account number. Select
the account number from the drop-down menu. Click the Search button to proceed.

Approved List

Account:

& 0

FFFriends - 01111 iearch Cancel
FFF Payroll - xxxx2222
FFF Expense - xxxx3333
FFF Escrow - xxxx4444

Company Name ¢

Approved List
Company ID ¢ Maximum Amount ¢ Frequency ¢ Start Date ¢ End Date ¢ Action

4. All Approved List entries for that account number will be displayed.
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Approved List

Account: FFFriends - xxxx1111

Maximum Amount ¢

Company ID ¢

Company Name ¢

ACME Acme Widget $20,000.00
CANOVA Richard Canova $10,000.00
CLEARY Frank Cleary $1,000.00
RICHARDS Richards & Assoc $10.000.00
TJONEST Tom Jones $50,000.00

Search Cancel

Approved List

Frequency ¢ Start Date ¢ End Date ¢ Action
YEARLY 06/18/2020 View
DAILY 06/19/2020 View
WEEKLY 06/19/2020 View
MONTHLY 06/19/2020 07/19/2020 View
MONTHLY 06/18/2020 View

5. Clicking the Cancel button at any time on this screen will navigate the user back to the ACH Filter Debit

welcome screen.

6. The user may view Approved List details for any company by clicking the View hyperlink in the Action

column.

Approved List

Account:

Company ID &
ACME
CANOVA

FFFriends - xooc1 111

Company Name <
Acme Widget
Richard Canova

Maximum Amount <
$20,000.00
$10,000.00

Search Cancel

Approved List

Frequency ¢ Start Date
YEARLY 06/18/2020
DAILY 06/19/2020

End Date ¢ Action
View dfpm—

View

7. The Approved List Details screen will display company detail, including all accounts included on the

Approved List

. Click the Back button to return to the Approved List Report screen.

Company Detail

Company ID ACME

Max Amount $20,000.00
Start Date 06/18/2020
Accounts

* FFFriends -xeoed 111

* FFF Payroll - 002222

* FFF Expense - xxxx3333
* FFF Escrow - xxxxdd44d

Back

Company Name Acme Widget
Frequency YEARLY
End Date
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The Block List report makes it easy for users to identify all the companies set up on the block list for a specific

account.

1. Within the ACH Filter Debit Module, click Reports > Block List.

£ Mana 10 - _/‘ Perform « 4 Reports « 'g ransaction History

Approved List

| Block List Joo——

Notification Rules Report

elcome

p use the above menu to select an action

2. The Block List Report page appears

Block List
Account: - All- -
Search Cancel
Block List
CompanyID 2 Company Name £ Start Date & End Date %
MAX Maximum Focus 06/20/2020

Action

View

3. The Account drop-down menu will allow the user to search approved list entries by account number. Select
the account number from the drop-down menu. Click the Search button to proceed.

Block List

Account: [ All - [ _]
- All -
FFFriends - 01111 iearch Cancel
FFF Payroll - xxxx2222
FFF Expense - xxxx3333
FFF Escrow - xxxx4444 Block List

Company ID ¢ Company Name ¢ Start Date ¢ End Date &

Action

4. All Block List entries for that account number will be displayed.
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AO3
DD1
MAX

Block List

Account:

Company ID &

SKETCH

FFFriends - 01111

Company Name &
Armada Resources
Dogwood Designs
Maximum Focus

Sketchy Corp

Search Cancel

Block List
Start Date ¢
06/19/2020
06/19/2020
06/20/2020
06/19/2020

End Date Action
View
View
View

View

5. Clicking the Cancel button at any time on this screen will navigate the user back to the ACH Filter Debit
welcome screen.

6. The user may view Block List details for any company by clicking the View hyperlink in the Action column.

AD3

oDl

Block List

Account:

Company ID ¢

FFFriends - 01111

Company Name &
Armada Resources

Dogwood Designs

Search Cancel

Block List
Start Date ¢
06/19/2020
06/19/2020

End Date ¢ Action
ViEw  pm—
View

7. The Block List Details screen will display company detail, including all accounts included on the Block List.

Click the Back button to return to the Block List Report screen.

Back

Company Detail

Company ID
Start Date

Accounts

FFFriends - oox1111
FFF Payroll - xxxx2222
FFF Expense - xxxx3333
FFF Escrow - jonoadddd

Pra—

AD3
06/19/2020

Company Name
End Date

Armada Resources
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l. Notification Rules

Notification rules establish who should be alerted, how they should be alerted and the conditions
that should prompt an alert. Notification rules can be set on an account by account basis or all
accounts can be configured with the same notification rules. The two notification options are email
and SMS text. SMS text will only be available if the feature has been enabled by the financial
institution.

By entering a cell phone number for SMS text alerts, you are opting to receive text messages. Note
that additional fees from your carrier may apply. To opt out, simply remove the cell phone number
from the user interface and click Save.

A. Setup Notification Method and Condition

1. From the ACH Filter Credit Module, click Manage > Notification Rules.

ACH Filter Credit | ##Manage ~  # Perform - diReports + = Transaction History

Motification Rules ‘

Approved List

Block List Welcome

Please use the above menu to select an action

2. The Manage Credit Notification Rules page appears. The Selection screen is the first screen of the
Notification Rules page and will display a list of all accounts that the user has access to.

LGB Contacts  Conditions  Confirm

Account Selection

Select Account(s) Account(s) Selected

CPP767Test] - xxxx7677 *
Client 8 Main - xxxx7678 *
Client 8 Expense - XXxx7679 * o

*Accounts with default Notification Rules

-+ Next
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NOTE: All accounts with the asterisk (*) symbol have not been configured, and have the default notification
rules, set up with the notification method via email. The email will be delivered to the default notification
contact established by the Bank, until such time the account is configured. The default notification condition is
to Notify for All ACH Credits.

3. Select the accounts to be configured and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Once all accounts have been selected, click the Next button to proceed.

m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
CPP767Test] - 07677 * Client 8 Main - xxxx7678 *

-+

Client & Expense - xxxx7679 *

1

*Accounts with default Notification Rules

— o Next

4. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will
allow entry of up to 6 email addresses and up to 6 cell phone numbers for SMS text.

Selection Conditions = Confirm

Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH credits to Lera Lynn (Idelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 Cell Phone 4
Cell Phone 2 Cell Phone 5
Cell Phone 3 Cell Phone &
E-mail
Email 1 Email 4
Email 2 Email 5
Email 3 Email &
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5. Toadd a cell phone number, enter the 10-digit cell number in the Cell Phone 1 field. Repeat this

process to add up to five additional cell phone numbers.

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 ) Cell Phone &

6. Toadd an email address, enter the email address in the Email 1 field. Repeat this process to add up

to five additional email addresses.

E-mail
Email 1 leralynn@client8.com M il 4
Email 2 miked@client8.com Email 5
Email 3 Email 6

7. Once all cell phone numbers and email addresses have been added, the user can proceed to the
next step by clicking the Next button. Clicking the Next button saves the data and moves to the next
step. The user can click the Back button to go back to the Selection page, but the user will lose all

data entered on this screen.

Selection Conditions Confirm

Enter the contact information to receive the ALERT

To change this enter contact information below.

This account is currently set to send all notifications on all ACH credits to Lera Lynn (Idelaere@achalert.com).

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 Cell Phone &
E-mail
Email 1 leralynn@clients.com Email 4
Email 2 miked@clients.com Email 5
Email 3 Email 6
= Back -efe—

—

= Next
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8. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can
define the criteria for when alerts should be sent. It is important to note that the alert criteria
controls the alerting process but does not control the transaction status designated at load time.
The transaction status is controlled by the default setting, approved and block list settings. Only one
radio button can be selected.

Selection Contacts FQOGIGHEE Confirm

&  Notify for all ACH Credits

Select a condition to receive the Alert

Notify only when an ACH Creditis over

Notify only when an ACH credit is received from a Company not on the Approved List or does not meet the parameters on the Approved List

Notify for all ACH Credits An alert will be sent for every ACH credit received on the accounts

configured with this notification condition.

Notify only when an ACH Credit is over e Enter the dollar amount.
o Alerts will only be sent when an ACH Credit is received that is greater
than the dollar amount established.
e Alerts will not be sent when an ACH Credit is received that is equal to
or less than the dollar amount established.

Notify only when an ACH Credit is An alert will be sent only when an ACH credit is received on the account
received from a Company that is not on from a company not set up on the approved list or is set up on the

the Approved List or does not meet the approved list but violates one of the additional parameters set, such as
parameters on the Approved List maximum amount, frequency, or start or end date.

Alerts will NOT be sent on ACH credit transactions that are received from
companies set up on the approved list and are within approved list
parameters. Those transactions will receive a status of approved list pay.
However, the status can be changed from within Transaction History.

9. Click Next to go to the Confirm page. Review all the information entered, and if correct, click the
Save button. If changes need to be made, click the Back button to navigate back to the appropriate
screen.
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Confirm Notification Rules

Xxxx7678

Cell Phone 1: 5554443333
Cell Phone 2: 8182099402
Cell Phone 3:

Address 1: leralynn@clients.com

Address 2: miked@client8.com
Address 3:

+ Back

Selection Contacts Conditions Eeslalildn}

Condition: Notify for all ACH Credits

Account(s) Selected

Cell Phone Text

Cell Phone 4:
Cell Phone 5:
Cell Phone 6:

Emails

Address 4:
Address 5:
Address 6:

Notification Condition

Save

Once Save has been clicked, a success message will appear.

If the default notification rules have been changed, the account will no longer have an asterisk (*)

If the user would like to restore the default contact and conditions, they may do so by navigating to
the Contacts screen, where there will now be an option to select a checkbox to use default contact

and conditions.

Cell Phone 1

Cell Phone 2

Cell Phone 3

Email 1

Email 2

Email 3

+ Back

Selection Conditions Confirm

Enter the contact information to receive the ALERT

(555) 444-3333

(818) 209-9402

leralynn@clients.com

miked@client8.com

Use Default Contact and Conditions i

Cell Phone Text

Cell Phone 4

Cell Phone 5

Cell Phone 6
E-mail

Email 4

Email 5

Email &
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1. Transaction History

ACH Filter Credit Transaction History allows authorized users to search and view all ACH credits that have been
received on enrolled accounts, and to make decisions on items. Users can use Transaction History to search for
ACH transactions for a specific account using one of the many filtering options available.

View Transaction History

Transactions are available in transaction history for one (1) year.

The Transaction History user privilege must be enabled to access this screen.

If the user has been granted the Change Status user privilege and the transaction is available to decision, the
Pay and Return buttons will be available for use.

Transactions that will be paid will have green shading as a background.

e Transactions that will be returned will have yellow shading as a background.

e Transaction in a return status cannot be changed after the EOD cut-off time.

o o o

1. There are two ways to navigate to the Transaction History page. One option is to navigate directly to
ACH Filter Credit Transaction History from the Dashboard, by clicking on any dollar amount displayed
within the ACH Filter Credit Dashboard. When using this option, Transaction History will only display
transactions included in the category selected. In the example below, the user would see only
transactions with a System Pay status. To see all transactions, click on Total ACH Credits.

PRO-TECH CR

End of Day Cut-Off Time: Wednesday 4:00 PM EST
Total ACH Credits $78,836.40 [ 35 ] Pending Approval $3,400.00 (2]
Setto Pay $45,836.40 €  settoRetun $33.000.00 o
System $45,836.40 fmmm— a System $0.00 (0]
User $0.00 (0] User $0.00 (0]
FI $0.00 (0] F1 $0.00 (0]
Approved List $0.00 (0] Block List $33,000.00 [5]
Approved List Exceptions $45,836.40 €  Block List Returns $33,000.00 9]

Another option is to navigate within the ACH Filter Credit module, to the View menu and click Transaction
History.
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ACH Filter Credit  # Manage ~  # Perform ~  JiReports ~ = Transaction History «

Welcome

Please use the above menu ta select an action

2. The Transaction History page will display all current day transactions for all accounts to which the user
has access.

” ; . Date Range
Credit Transaction History iﬂovembe?s i
Y Filters >
Date Company Account # Amount Current Status Manage
> 11/06/2020 Olivia's Omelett xox1111 $3,200.00 Pay - System ® Reject
> 11/06/2020 Olivia's Omelett 01111 $3,200.00 Pay- System
> 11/06/2020 Niveena's Natura 001111 $100.00 Pay- System
> 11/06/2020 Niveena's Natura 0001111 $100.00 Pay- System
> 11/06/2020 Marshall Modelin 001111 $47.00 Pay- System
> 11/06/2020 Marshall Modelin xox1111 $47.00 Return - User
> 11/06/2020 Leningrad Livery 01111 $2,800.00 Pay- System
Date Date the ACH credit was presented or loaded to ACH Filter Credit.
Company Name of the company crediting the account. This information is obtained from the company name
field in the batch header record of the ACH transaction.
Account Account number the ACH credit was presented against.
Number
Amount Amount of the ACH credit.
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Status

Pay

Return

Pay-System

Pay-User

Approved List-
Pay

Pending-Pay

Pay-FI

Pay-FI Charge

Return-
System

Return-User

Description

Transactions that load with this status
indicate the default condition established
by the financial institution is to pay all
transactions on this account if users take
no action.

Indicates a user has changed the status of
a transaction from Return to Pay.

Transactions that load with this status
indicate the company that originated the
transaction was set up on the approved list
for this account prior to receipt of the
transaction and the transaction amount,
frequency and date are within the
allowable parameters specified in the
approved list entry.

Indicates a user has changed the status of
the transaction from Return to Pay, but the
decision must be approved by a secondary
user because Decision Dual Approval has
been enabled.

Indicates an Fl user has changed the
status of a transaction from Return to Pay.

Indicates a transaction for a Company 1D
that is on the FI Return Override List and
the status cannot be changed from Pay to
Return.

Transactions that load with this status
indicate the default condition established
by the financial institution is to return all
transactions on this account if users take
no action.

Indicates a Bank user has changed the
status of a transaction from Pay to Return.

2T N

Change Allowed Until

Return deadline, account
type and transaction type.

Return deadline, account
type and transaction type.

Return deadline, account
type and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

No changes to this status
are allowed.

Up until EOD cut-off time.

Up until EOD cut-off time.

53



ACH Filter
User Guide

A T1 N

Block List- Transactions that load with this status Up until EOD cut-off time.
Return indicate the company that originated the

transaction was set up on the blocked list

for this account prior to receipt of the

transaction.
Return-FI Indicates a Bank user has changed the Up until EOD cut-off time.
status of the transaction from Pay to
Return.
Manage If the user has been granted the Change Status user privilege and the transaction is eligible for a

decision, an Accept or Reject button will appear for use. If the transaction is not eligible for a
decision, (because the return deadline or end of day cut-off time has passed) the button will display
as ineligible.

a. Tofilter the date range of items shown, click on the Date Range drop-down.

Credit Transaction History Eate ik
s November 6, 2020~
Y Filters T
250f35 Yesterday
- =X I Last 7 Day
Date Company Account # Amount Current Status Last Month
> 11/06/2020 Olivia's Omelett 200%1111 $3,200.00 Pay - System Custom Range
m Cance!
> 11/06/2020 Olivia's Omelett w1111 $3,200.00 Pay- System st

b. To narrow the search results, click Filters and a window containing additional search criteria will appear.

. . . Date R
Credit Transaction History ate fange

Eseptember 15, 2021 =

Y Filters v
Account’ Company’ Transaction Status
- not selected - v T Ime or Pay
Pay - System
Min Amount Pending Approval Pay - User
Approved List Pay
$ Show All v Pay- I
Max Amount Pay - FI Charge
Return
5 Return - System
Return - User
Return - FI

Block List Return

" key to select multiple status
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Account Type an account name or the last 4 digits of the account number into the field to view transactions
for one specific account or select an account from the drop-down menu.
Min Amount / To search for a transaction by amount within a minimum/maximum range, type the minimum
Max Amount and/or maximum dollar amount(s) of the transactions into the appropriate field.
Companies Enter a specific company name.
Pending The user may select from the drop-down to filter transactions based on whether or not they are
Approval pending approval.
» Yes — will display only transactions that are pending approval.
» No — will display only transactions that are not pending approval
The default will be set to “Show All”. For more information regarding Decision Dual Approval,
please see Subsection C, Decision Dual Approval, below.
Transaction See #2 in this subsection for definitions of the different transaction statuses.
Status

c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the results
will be displayed on multiple pages. Use the navigation buttons at the top of the search results to review all
results.

e. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The information
shown in this drop-down is an audit history of all the activity that has occurred on the issue item.
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Date Company Account # Amount Current Status Manage
> 0311072021 Olivia's Omelett xxx1111 $3.200.00 Pending-Pay @ Reject
¥ 03/10/2021 Olivia's Omelett 0ox1111 $3.200.00  Pay - System @ Reject
Account: WKP Main xox1111 SEC Code: PPD Add to Approved List || Add to Block List
Transaction ID: 73189163 Description: PTTest0216

Deadline To Return: Wednesday 4:00 PM EST
Individual Name: Olivia's Omelettes Trace #: 064208470003793

Company ID: 000008

~  03/10/2021 Niveena's Natura 001111 $100.00  Return - User

Account: WKP Main 1111 SEC Code: PPD Add to Approved List || Add to Block List

T 3t 1 73189161 cription: PTTest081
ransaction ID: 7318916 Description es0815 Deadline Ta Pay: Wednesday 4:00 PM EST

Individual Name: Niveena's Naturals Trace #: 064208470003791

Company ID: NOOOO8

Account The account name and last 4 digits of the account number.

Transaction ID Unique ID assigned by the ACH Filter Credit system when transactions are loaded.

Individual Name Name of the payee/recipient found in the individual ID field of the incoming ACH
transaction.

SEC Code Standard entry class code. Reference the NACHA Rule Book for SEC code descriptions.

SEC codes are generally used to classify transactions by the way they were authorized.

Description The description used by the originator of the transaction, as contained in the company
batch header record for the transaction received.

Trace # A unique ID assigned to the transaction by the originator, ACH operator or receiving
depository financial institution.

Company ID A unique identifier for the company that originated the ACH debit. This information is
obtained from the company ID field of the batch header record of the ACH transaction.
This unique identifier is used to match transactions to approved or blocked list entries.

Add to Approved List Will only appear if the user has Act on Approved list user privilege. Please refer to
Subsection Ill, Approved List within this Section for more information about this
feature.

Add to Block List Will only appear if the user has Act on Blocked list user privilege. Please refer to
Subsection IV, Blocked List within this Section for more information about this
feature.

Deadline to Pay/Return Deadline to change the status of any transaction from Pay to Return or from Return to
Pay.
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B. Change Transaction Status

1. If the user has been granted the Change Status user privilege and the transaction is eligible for a decision, an
Accept or Reject button will appear for use. If the transaction is not eligible for a decision, the button will
display as ineligible.

2. Change Status — Accept
a. If the Current Status on an issued item is set to Return, the user can opt to change the status to Pay if
the user determines the credit transaction should be paid.
b. Click the Accept button under the Manage column

Date Company Account # Amount Current Status Manage

> 11/06/2020 Olivia's Omelett 01111 $3,200.00  Pay- System ® Reject
> 11/06/2020 Olivia's Omelett 01111 $3,200.00  Pay- System ® Reject
> 11/06/2020 Miveena's Natura xox1 111 $100.00  Pay - System ® Reject
> 11/06/2020 Miveena's Natura xox1 111 $100.00  Pay - System ® Reject
> 11/06/2020 Marshall Medelin 01111 $47.00  Pay- System ® Reject
¥ 11/06/2020 Marshall Modelin xox1111 $47.00  Return - User @ Accept

> 11/06/2020 Leningrad Livery 01111 $2,800.00 Pay- System ® Reject

c. Click the Accept button under the Manage column.

d. A success message will appear temporarily in the Manage column, with an option to Add to Approved
List. This link will only appear if the user has the Act on Approved List user privilege. The user can click
the hyperlink embedded in that option to proceed to Add to Approved list. If the user does not opt to
Add to Approved list at this time, the option is still available under the expanded view of this debit item.

Date Company Account # Amount Current Status Manage
» 11/06/2020 Olivia's Omelett oo 111 $3,200.00 Pay - System ® Reject
> 11/06/2020 Olivia's Omelett wox1111 $3,200.00 Pay- User Credit will be paid.
= Add to Approved List

e. After afew moments, the Change Status button will then change to Reject, and the Current Status
column will update to “Pay-User.”

57



ACH Filter
User Guide

A T1 N

Date Company Account # Amount Current Status Manage
» 11/06/2020 Olivia's Omelett oo 111 $3,200.00 Pay- System ® Reject

> 11/06/2020 Olivia's Omelett oo 111 $3,200.00  Pay- User @ Reject

3. Change Status — Reject

a. If the Current Status on an issued item is set to Pay, the user can opt to change the status to Return if
the user determines the debit transaction should be returned.
b. Click the Reject button under the Manage column.

Date Company Account # Amount Current Status Manage
> 11/06/2020 Olivia's Omelett 61111 $3,200.00 Pay - System ® Reject —
> 11/06/2020 Olivia's Omelett xx1111 $3,200.00 Pay- User ® Reject
> 11/06/2020 Niveena's Natura X0x1111 $100.00 Pay - System ® Reject

c. A success message will appear temporarily in the Manage column, with an option to Add to Block List.
This link will only appear if the user has the Act on Block List user privilege. The user can click the
hyperlink embedded in that option to proceed to Add to Block list. If the user does not opt to Add to
Block List at this time, the option is still available under the expanded view of this credit item.

Date Company Account # Amount Current Status Manage

> 11/06/2020 Olivia's Omelett 001111 £3,200.00 Return - User

> 11/06/2020 Olivia's Omelett 0001111 $3,200.00 Pay- User

d. The Change Status button will then change to Accept, and the Current Status column will update to
“Return-User.”

Date Company Account # Amount Current Status Manage

» 11/06/2020 Olivia's Omelett 01111 $3,200.00 Return - User @ Accept

C. Decision Dual Approval

ACH Filter Credit offers the ability to support dual approval for user decisioning. If Decision Dual Approval is
enabled, and a user has decisioned any transaction in the Transaction History to the status of Pay, the
transaction will be listed as Pending-Pay and an alert message will be sent via email and/or SMS text message
requesting the approval of the change of the transaction status. . The secondary user must approve the
transaction decision.
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1. Within the ACH Filter Credit module, click Perform > Transaction Approval.

i

£ Manage = # Perform = ol Reports =

[ Transaction Approval |

come

e the above menu to select an action

2. The Credit Transaction Approval screen will display.

Credit Transaction Approval
R
Select
fsil}:none] Date Company Account#  Amount Current Status Requested Statusli
> O 03/10/2021 Del Aire Develop xxxx1111 $1,700.00 Block List Return Pay
> O 03/10/2021 Del Aire Develop xxxx1111 $1,700.00 Block List Return Pay
Select [all | none] The user can opt to select individual transactions by clicking the checkbox at the

left of the row. The user can also select all transactions by clicking “all” in the
Select column. The user can de-select all transactions by clicking “none”.

Date Date of the transaction.

Company Name of the company crediting the account.
Account Number Displays the masked account number for the item.
Amount Amount of the credit transaction.

Current Status Current status of the transaction.

Requested Status The status of the transaction, if approved.

3. Clicking the arrow (>) at the far left of each row will expand the view for more pertinent information about
the transaction.
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Select

Il
Lal}inone] Date Company Account # Amount Current Status Requested Statusli

v 03/10/2021 Del Aire Develop Xxxx1111 $1,700.00 Block List Return Pay

Transaction ID: 73189119

Requested By: FFFTomjones

Transaction ID Unique ID assigned by the ACH Filter system when transactions are loaded

Requested By The user who has requested the change of transaction status.

4. After examining the transactions pending approval, the user can select items to approve or deny by clicking
the Approve or Deny buttons at the bottom of the screen.

5. If atransaction is Approved, a Confirm Approval pop-up window will appear. The user can click the Confirm
button to confirm the approval of the transaction status change or click the Cancel button to return to the
Credit Transaction Approval Screen.

Confirm Approval

Approve status change of 1 transaction

Click Cancel to return or Confirm to continue

6. If atransaction is Denied, a Confirm Rejection pop-up window will appear. The user can click the Confirm
button to confirm the rejection of the transaction status change or click the Cancel button to return to the
Credit Transaction Approval Screen.

Confirm Rejection

Reject status change of 1 transaction

Click Cancel to return or Confirm to continue

NOTE:
It is important to note that if a transaction decision is currently awaiting approval from a secondary user and
the transaction is not approved or rejected by EOD, the transaction will revert to its original status. For
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instance, if a transaction is set to default return and a user decisions the item to be paid, if that decision is
not approved by EOD, the item will revert to the default return status.

lll.  Approved List

The Approved List allows Customers to identify companies that are allowed to credit an account or accounts and
set parameters to control the credit activity. There are multiple ways to populate the approved list. It can be
done through the Setup > Approved List menu option, or users can add companies to the approved list from
Transaction History. It is important to note that companies added from Transaction History will only be added to
the account associated with the transaction it was added on. To allow the company to credit other accounts, the
user must edit the approved list.

Users can edit and delete companies from their approved list.

The way ACH Filter Credit identifies approved companies is by verifying the company ID ONLY in the batch
header record of the incoming ACH transaction is an exact match. If an exact match is found, if additional
parameters have been established such as maximum amount, frequency, start/end date, the values found in the
ACH batch/transaction are compared to the list to determine if an alert is required and the transaction status
that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the approved list is
shown below.

Verifies Company ID

101 026013262 0642085182008060950A094101DaLa Bank & Trust FRB Atlanta

5200Ashland Armament A00008]  PPDPTTest0820 200806  1064208470000031
6220260132627677677678 0000150000A00008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
82000000020005202652000000030000000000150000800008 064208470000031
5200Biolab Birmingha PPDPTTest0805 200806  1064208470000032
6220260132627677677678 Biolab Birmingham 0064208470000395
6270260132627677677678 Biolab Birmingham 0064208470000396
82000000020005202652000000250000000000 064208470000032
5200Cartwright Car S PEPDPTTest0806 200806  1064208470000033
6220260132627677677678 Cartwright Car Sales  0064208470000397
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop D00008  PPDPTTest0804 200806  1064208470000034
6220260132627677677678 0000170000D00008 Del Aire Developers 0064208470000398
6270260132627677677678 0000270000D00008 Del Rire Developers 0064208470000399
82000000020005202652000000270000000000170000D00008 064208470000034
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101 026013262 0642085182008060550A094101DeLasxre Bank & Trust

FBRE Atlanta

5200Ashland Armament AQQOOB PPDPTTest0820 200806 10642084T70000031
6220260132627677677678 0000150000400008 Ashland Rrmament 00E4208470000353
E270260132627677677678 QQ00030000400008 Ashland Armaments 00E42084T0000354
82000000020005202652000000020000000000150000R00008 0E42084T0000021
5200Biclab Birmingha BOOOOS PPDPTTest0805 200806 1064208470000032
E220260132€2767T7677678 OO00130000p0000E Biclak Birmingham 00E42084T0000355
E270260132627677677678 0000250000p0000S Biclab Birmingham 00E4208470000396
82000000020005202652000000250000000000120000B00008 0E42084T70000032
Compares against Frequency and Start/End Date Parameters

101 026013262 0642085182008060550A054101DeLacre Bank & Trust FRE ::ffff

5200Ashland Armament AQODOOE PFDFTTest0820 1 2008086 1064208470000031
6220260132627677677678 0000150000R00008 Ashland Armame 00E42084T70000353
€270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
B2000000020005202652000000030000000000150000A00008 GE420B84T00000321
5200Biclab Birmingha BOODOODE FEDFTTest 08053 10e42084700000322
6220260132627 TTETTETE Q0001300008B00008 Biolab Bim_ingham 00E4208470000355
627026013262T7c7T767T7678 0000250000B800008 Bioclab Birmingham 00c420847000035%6
B820000000200052026520000002500000000001320000800008 0e4208470000032

If the notification criteria is set to Notify when a credit comes in from a company not on the approved list or
violates approved list parameters, PRO-TECH CR will alert designated contacts when a credit is received from an
unknown company or from a company that is set up, but violated the parameters. If notification criteria are set
to all credits, credits over a certain amount or certain types of credits, the system will NOT alert for approved list
violations. If the transaction meets approved list criteria, it will receive a status of Approved List-Pay. If it does
not, it will receive the system default status.

A. Add to Approved List from Setup Menu
1. Within the ACH Filter Credit module, click Manage > Approved List

oM # Perform =

andage =

Natification Rules

[ Approved List | s

Block List

F the above menu to select an action

o Reports - i= Transaction Histon

2. The Credit Approved List will display. Click the Create button to add an entry to the Approved List.

¥ Delete Selected

+ Creats lf—
Approved List
Company ID £ Company Name &
Delete Maximum Amount Frequency
ADD0E Ashland Armament $12.000.00

Start Date

OBF0S/2020

End Date

-]

Edit

Edit

Cancel
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3. The Add Company page will display. Complete all applicable fields in the top section of the screen.

Approved Compary

Company Detail

Company 1D Company Name
Max Aot Frequency Mo Frequency
Start Date 0B/O5/2020 End Date

Add ACCOUNTS 10 Approved List
CPPTETTELL] - Xk PETT

Client 8 Expense - DO 7679
Client 8 Main - 0007678

- Save @ Cance|

Field Name Optional | Field Validated Field Content Notes
or
Required
Company ID Required | Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)

(space)
_ (underscore)

Company Optional | Not Validated Max: 16 Valid Characters:
Name A-Z

a-z
# (number sign)
0-9

, (comma)

- (dash) (space)
_ (underscore)
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value.

If the transaction with the
highest dollar value exceeds
the Maximum Amount, all
transactions on the file are not
approved.

If the transaction with the
highest dollar value is equal
to or less than the Maximum
Amount, that transaction is
approved and all other
transactions on the file are
not approved.

calendar days

o Bi-Weekly: 14
calendar days

¢ Monthly:

Monthly date-
to-date

e Quarterly:
Quarterly date-to-
date

o Yearly: Yearly date-
to-date

Date-to-Date
Exceptions:

e Non-Leap Year
January 29, 30, 31:
February 28

e Leap Year January
30, 31, February 29

e March 31: April 30

e May 31:June 30

e August31:
September
30

e October 31:
November
30

Max Amount | Optional The transaction meets the e Blank: Any amount | Valid Characters:
parameters when the amount is accepted and will | 0-9
the amount is less than or not trigger an alert.
equal to the Max Amount e Zero: Will not be
The transaction does not accepted and
meet the parameters when entry will not save
the amount is greater than to Approved List.
the Max Amount. e Highest amount:
$99,999,999.99
Frequency Optional If multiple transactions are e Daily: 1 business Counter:
on a file, the sort order is day
highest to lowest dollar o Weekly: 7 The counter

begins with the
first transaction
received after
the Company
and Account is
added to the
Approved List
regardless if the
transaction
meets or does
not meet the
parameters of
the Approved
List.
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Start Date Required | e The transaction meets the

parameters when the date is
equal to or after the Start
Date.

e The transaction does not
meet the parameters when
the date is before the Start
Date.

The Start Date is
based on the

settlement date.

Valid Characters:
0-9

End Date Optional | e The transaction meets the
parameters when the date is
equal to or before the End
Date.

e The transaction does not
meet the parameters when
the date is after the End
Date.

e The transaction meets the
parameters when the field is
blank.

The End Date is
based on the
settlement date.

Valid Characters:
0-9

4. Choose from the list of available accounts to add to the Approved List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Approved List

CPPTETTegt] - e TETT Clieng 8 Expengs - o TETI

Client 8 Main - 0007678

a~ Save @ Cancel

5. Once the entry is completed, click Save to save it to the Approved List. A success message will appear.
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+ Create

Delete

8 Delete Selected

Company ID ¢

W Approved Company Saved Successiully

Approved List
Company Name &
Maximum Amount Frequency Start Date End Date
Ashland Armament $12.000.00
Hats on Hean St $5.000.00

Edit

Edit
Edit

® Cancel

6. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be taken
to the Company’s screen.

B. Add to Approved from Transaction History

1. From the Transaction History page, click the > arrow to expand the entry of the ACH credit transaction.

Date

> 08/07/2020

v 08/07/2020

Transaction ID: 7317

Account: Client 8 Main 07678
9180

Individual Name: Leningrad Livery

Company Account # Amount Current Status Manage
Marshall Modelin 07678 $47.00  Pay-System
Leningrad Livery XOX7678 $2.800.00 Pay-System

SEC Code: PPD dlist  Addio Block List

Description: PTTes

Deadline To Return: Friday 4:00 PM EDT
Trace #; 064208

Company 1D: LOO00S

2. Click the Add to Approved List button to add a company. The Add Company pop-up window will appear.

the transaction received.

Add Company to Approved List
Company Id Company Name Start Date End Date
L00008 Leningrad Livery 8 08/07/2020 =
Max Amount Frequency
2800 -none v
Field Description Can Be Modified
Company ID Populates with company ID data from the batch header record of

Company Name

Populated with the company name data from the batch header
record of the transaction received.

v
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Max Amount Populated with amount of transaction received. v
Frequency Left blank. v
Start Date Populated with the date of transaction received. v
End Date Left blank v

3. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History without
adding to the Approved List.

4. The user will be directed to the Transaction History page once the company has been added to the
Approved List.

C. Approved List Failure Reasons

When a transaction exception is triggered because of Approved List parameters, the system default status will
apply. Examples of types of failure reasons are listed below.

Reason

Description

Sample

Transaction
Amount is
Greater than
Approved List

Dollar amount of transaction is
greater than the maximum amount in
the Approved List entry.

Current Status Manage

Amount Add to Approved List Add to Block List
Deadline To Return: 08/16/2020 5:00 PM EDT
Approved List Violation: Transaction Amount: 1500 is greater than Approved
List amount: 1000

Frequency Transaction violates the frequency set

Failure in the Approved List entry.

Add to Approved List Add to Block List

Deadline To Return: 10/03/2020 4:00 PM EDT

Approved List Violation: Frequency: YEARLY Last Transaction Date:
06-AUG-20
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Out of Date Transaction was presented prior to
Range the Start Date or after the Ending Pay - System
Date of the Approved List entry.

Add to Approved List Add to Block List

Deadline To Return: 08/13/2020 5:00 PM EDT
Approved List Violation: Out of Date range - Start Date: 18-JUN-20 End Date:

IV. Block List

The Block List is an optional feature which, if enabled by the Fl, allows Clients to identify companies that are
NOT allowed to debit an account or accounts. There are multiple ways to populate the block list. It can be done
through the Setup > Approved List menu option, or users can add companies to the block list from Transaction
History. It is important to note that companies added from Transaction History will only be added to the account
associated with the transaction it was added on. To prevent the company from debiting other accounts, the user
must edit the block list.

Users can edit and delete companies from their block list.
If an exact match is found, if additional parameters have been established such as start or end date, the values
found in the ACH batch/transaction are compared to the list to determine if an alert is required and the

transaction status that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the blocked list is
shown below.

Verifies Company ID

101 026013262 0642085182008060950A0541 e Bank & Trust FRE Atlanta

S200Ashland Armament PPDPTTest 0820 200806€ 1064208470000031
6220260132627677€77678 0000150000A00008 Ashland Armament 00€42084700003%3
€2702€0132€27€77677¢678 0000030000A00008 Ashland Armaments 006420847000039%4
82000000020005202€52000000030000000000120000800008 064208470000031
5200Biolab Birmingha B00008 PPDPTTest0805 200806 1064208470000032
€220260132627677677678 0000130000B00008 Biolab Birmingham 00€4208470000355
€270260132627677677678 0000250000B00008 Biclab Birmingham 00€42084700003%6
82000000020005202€52000000250000000000130000800008 064208470000032
S200Cartwright Car S c00008 PPDPTTest0806 200806 10€4208470000033
€2202€0132€27677¢€77€78 0000800000C00008 Cartwright Car Sales 0064208470000397
82000000010002601326000000000000000000800000C00008 0€4208470000033
S200Del Aire Develop D00008 PPDPTTest0804 200806 1064208470000034
€2202€0132€27€677677678 0000170000D00008 Del Aire Developers 00€420847000039%8
€2702€0132€27€77677678 0000270000D00008 Del Aire Developers 00€42084700003%9%
82000000020005202€52000000270000000000170000D00008 064208470000034
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Compares against Start/End Date Parameters

101 026013262 0642085182008060550A054101DeLasre Bank & Trust FRE Atlanta
3200Ashland Armament AQOOQO0E PFDFTTest0820 200808 1064208470000031

€22026013262TETT7€7T7678 QOO0L50000R00008 Ashland Armame QOE42084T00003593
E2T02E013262TETTETTETR QOO0030000R00008 Ashland Armaments GOE42084T0000354
82000000020005202652000000030000000000150000R00008 0E42084T0000031
5200Biclab Birmingha BOOODOB FFDPTTest0805 106420847T0000032
6220260132e2T767767T7678 QQ000120000B00008 Biclab Birmingham 00e42084T0000333
6270260132627 7T7ETTETH QDO0230000800008 Bioclab Birmingham 00Ee42084T0000356
82000000020005202652000000250000000000120000B00008 064208470000032

Blocks are intended to automatically return items and alerts are not sent out. However, Clients can see those items
in transaction history and have the option to pay them before EOD cut-off time. The dashboard will be updated in
the next release to display blocked item summary information.

A. Add to Block List from Setup Menu

1. Within the ACH Filter Credit module, click Manage > Block List

L Manage »  # Perform =  JReports = i Transaction History

Naotification Rules
Approved List

| Block List Je—

B the above menu to select an action

2. The Credit Block List will display. Click the Create button to add an entry to the Block List.

+ Create
Block List
Delete Company [0 0 Company Nems o Start Date End Date Edit
SKETCH Sketchy Corp 06/19/2020 Edit
¥ Delete Selected @ Cancel

3. The Add Company to Debit Block List page will display. Complete all applicable fields in the top section of the
screen.
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Blotked Company

Company Detail

Company ID Comparry Marme

Start Date OEBII000 End Date

Add Accounts to Block List

FFF Escrow « )ooordddd

FFF Expense - 10003333

FFF Payroll - oo 222

FFFrignds - xoocl 111

~ Save @& Cancel

Field Name Optional or Field Validated Field Content Notes
Required
Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)

(space)
_ (underscore)

Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
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Start Date Required e The transaction The Start Date is Valid Characters:
meets the parameters
when the date is based on the settlement 0-9
equal to or after the date.
Start Date.

e The transaction does
not meet the
parameters when the
date is before the
Start Date.

End Date Optional ¢ The transaction The End Date is based |Valid Characters: 0-9
meets the parameters  0n the settlement date.
when the date is
equal to or before the
End Date.

e The transaction does
not meet the
parameters when
the date is after the
End Date.

e The transaction
meets the parameters
when the field is
blank.

4. Choose from the list of available accounts to add to the Block List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Block List

FFF Expense - nox3333 FFF ESCrow - xaoondAdd
FFF Payrpdl - oo 223 N

FFFriends - o1 111

~ Save @ Cancel

5. Once the entry is completed, click Save to save it to the Block List. A success message will appear.
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WV Blocked Comparry Sived Successiully
+ Create
Block List
Company [D & Compary Name 2
Delete Start Date End Date Edit
AN Maximum Focus 0671972020 Edit
SKETCH Sketchy Corp D6/ 1902020 Edit
B Delete Selected 2 Cance

6. To edit any entity on the Block List, click the Edit hyperlink at the endo the appropriate row to be taken to the
Company’s screen.

7. To Delete any entity on the Block List, click the checkbox next to the appropriate row, and click the Delete
Selected button.

B. Add to Block List from Transaction History

1. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Oate Company Account & Amount Current Status Manage

% 11/06/2020 Olivia's Omelett oot 111 $3,200.00 Return - User @A«ep(
v 11/0672020 Olivia's Omelett o111 $3.20000  Pay- User

Account: WKP Main xooc1 111 SEC Code: PPD

A40 10 Approved Ust AS3 w0 Bk Ust

Description: PTTest0216

Deadline To Return: Friday 4:00 P\
Individual Name: Ofivia's Omelettes

Company ID: 000008

2. Click the Add to Block List to add a company. The Add Company pop-up window will appear.

Add Company to Block List
Company Id Company Name Start Date End Date
MO00008 Marshall Modelin = 08/07/2020 =
Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header
record of the transaction received.
Company Name Populated with the company name data from the batch header v
record of the transaction received.
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Start Date

Populated with the date the transaction was received. v

End Date

Left blank

v

3. Click the Save button to add to Block List. Click Cancel to return to the Transaction History without adding to
the Block List.
4. The user will be directed to the Transaction History page once the company has been added to the Block List.

C. Block List Failure Reasons

When a transaction exception is triggered because of Block List parameters, the system default status will apply.
Examples of types of failure reasons are listed below.

Reason Description Sample

Out of Date Transaction was presented prior to the

Range Start Date or af_ter the Ending Date of Block List Return or

the Approved List entry. ay
Add to Approved List Add to Block List
Deadline To Pay: Friday 4:00 PM EDT
Blocked List Violation: Account on Blocked List
V. Reports

Reports are available for one (1) year.

A. Notification Rules Report

The Notification Rules report provides authorized Client users a method to view the notification conditions set
for each account enrolled for the service. The report allows users to see the default account setting established

by the financial institution, as well as the notification condition and contact information established by the

Client.

1. Within the ACH Filter Credit, click Reports > Notification Rules Report.
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£ Manage « # Perform « Ji Reports « ig His
Approved List
Block List
come | Notification Rules Report | s
e the above menu to select an action

2. The Notification Rules Report page appears.

Account Number

Account
Setting

Pay All

Pay Al

Pay All

Notification Conditions for Client 3
Notification
Amount heck nter P mail

Condition € internet . Phone € Celiphone
1. mhart 1.5
2. fjones .81

All Debizs > 3
4 4
5 5
6 6.
1. mhart@ffriends.com 1. 5554443333
2. flones@ifriends.com 2. 8182095402

All Debits ‘: "
4, 4
5 5
6 6
1 1
2. f 2

All Debits > -
5‘ g
6. 6
1. mhart@{ffriends.com 1
2. flones@fffriends.com 2
3 3

All Debits .: ;
5. s
6. 3

Total count 4

Account Number

Account Setting

Notification Condition

Debit Amount

Check

The last 4 digits of each account number enrolled.

The default pay or return setting established by the financial institution when the account
was enrolled for the service.

o Pay All

e Return All

See Notification Rules section for detailed descriptions:
o All Debits

¢ Debit Over the Debit Amount

e Company Not in Approved List

If Notification Condition is Debit Over the Debit Amount, the amount entered will be
displayed.

¢ [f Notification Condition is ACH Debits with Check/Internet/Phone is selected
¢ If Check is selected, Y will be displayed.
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Internet o If Notification Condition is ACH Debits with Check/Internet/Phone is selected
o If Internet is selected, Y will be displayed.
Phone ¢ If Notification Condition is ACH Debits with Check/Internet/Phone is selected
o If Phone is selected, Y will be displayed.
Email Email address(es) that will receive email alerts.
Cell Phone Cell phone number(s) that will receive email alerts; this section will display only if the

financial institution is configured to allow SMS Text alerts.

B. Approved List Report

The Approved List report makes it easy for Client users to identify all the companies set up on the
approved list for a specific account.

1. Within the ACH Filter Credit Module, click Reports > Approved List.

£ Manage ~ # pPerform ~ diReports + = [
| Approved List } ¢—
Block List
come Notification Rules Report
the above menu to select an action

2. The Approved List Report page appears.

Approved List

Account: Al -

Search Cancel

Approved List
Company ID ¢ Company Name ¢ Maximum Amount < Frequency ¢ Start Date ¢ End Date ¢ Action

ACME Acme Widget $20.000.00 YEARLY

3. The Account drop-down menu will allow the user to search approved list entries by account
number. Select the account number from the drop-down menu. Click the Search button to
proceed.
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Approved List
Account: l all [.l
FFFriends - o111 earch Cancel
FFF Payroll - oox2222
FFF Expense - xo0x3333
FFF ESCrow - xox4444 Approved List
Company ID ¢ Company Name ¢ Maximum Amount ¢ Frequency ¢ Start Date ¢ End Date ¢ Action

4. All Approved List entries for that account number will be displayed.

Approved List
Account: FFFriends - ox1111 -
Search Cancel
Approved List

Company 1D ¢ Company Name Maximum Amount < Frequency ¢ Start Date © End Date ¢ Action
ACME Acme Widget $20.000.00 YEARLY 06/18/2020 View
CANOVA Richard Canova DAILY 06/19/2020 View
CLEARY Frank Cleary WEEKLY 020 View
RICHARDS Richards & Assoc MONTHLY 020 07/19/2020 View
TIONES? Tom jones MONTHLY 06/18/2020 ew

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH

welcome screen.

6. The user may view Approved List details for any company by clicking the View hyperlink in the
Action column.

Approved List

Account:

Company 1D ¢
ACME

CANOVA

FFfriends

Company Name 2
Acme Widget

Richard Canova

xox1111

Search Cancel
Approved List
Maximum Amount 2 Frequency ¢
$20.000.00  YEARLY
DAILY

Start Date ¢
061872020

06/19/2020

End Date ¢

Action
Vigw Cp—

7. The Approved List Details screen will display company detail, including all accounts included on
the Approved List. Click the Back button to return to the Approved List Report screen.
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Company Detall
Company [D ACME

Max Amount $20,000.00
Start Date 06182020
Accounts

FFFriends - oom1111
FFF Payroll - moc2 222
FFF Expense - oxxx3333
FFF Escrow - :onoidd44

Back

Company Mame Aome Widget
Frequency VEARLY
End Date

C. Block List Report

The Block List report makes it easy for Client users to identify all the companies set up on the block list for a specific

account.

1. Within the ACH Filter Credit Module, click Reports > Block List.

L Manage « L F m v ot Reports ~ = listor
Approved List
| Block List | ¢—
come Notification Rules Report
the above menu to select an action
2. The Block List Report page appears.
Block List
Agcount: adi -
Search Canced
Block List
Company ID % Company Mame 2 Start Date & End Date 3 Action
A Maximum Focus 062052020 Wiew

3. The Account drop-down menu will allow the user to search approved list entries by account number. Select the
account number from the drop-down menu. Click the Search button to proceed.
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Block List
ACCOURNT [ All [ ']
FFFriends - oo 111 R A
FFF Payroll - mom222
FFF Expense - Xoo 3333
FFF Escrow - soodddd Block List
Company ID = Company Name = Start Date End Date & Action
4. All Block List entries for that account number will be displayed.
Block List
Account FFFrignds - mom1117 =
Search Cancel
Block List
Compary ID ¢ Company Name o Start Date © End Date & Actian
AD3 Armada Resouroes 061977020 Wiew
Do Dagwasd Designs DEM 020 Wiew
MAX Maximum Focus 06/ 2072030 View
SKETCH Sketchy Corp 06192020 Wiew

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH CR welcome
screen.
6. The user may view Block List details for any company by clicking the View hyperlink in the Action column.
Blodk List
Arcount FRFriends - o 1111 =
Search Cancel
Black List
Company ID 2 Company Name & Start Date 2 End Date = Action
A3 Armada Resources (61502020 Vidw -f—
oo Dogwaod Designs B6/15/2020 Whew
7. The Block List Details screen will display company detail, including all accounts included on the Block List. Click

the Back button to return to the Block List Report screen.
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Company ID AD3 Company Name Armada Resources
Start Date 061192020 End Date

ACCounts

FFFriends - woocl 111
FFF Payroll - xoooa2222
FFF Expense - x3333
FFF Escrow - oooedddd
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Appendix A — Message Alerts

Service Alert Type Description Recipient
Module
PRO-TECH & Debit Notification Account Account Debit Notification Client
PRO-TECH CR
Credit Notification Account Account Credit Notification Client
Debit Notification Transaction Debit Transaction Notification Client
Credit Notification Transaction Credit Transaction Notification Client
Debit Service Alert Debit Service Alert Client
Debit Dual Decision Approval Protech Debit Dual Decision Approval Client
Reminder Reminder Alert
CR Dual Decision Approval Protech Credit Dual Decision Approval Client
Reminder Reminder Alert
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